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Before putting the product into operation for
the first time, make sure to read the following

Safety Instructions

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the
safety standard of our products up to date and to offer our customers the highest possible degree of
safety. Our products and the auxiliary equipment required for them are designed and tested in
accordance with the relevant safety standards. Compliance with these standards is continuously
monitored by our quality assurance system. The product described here has been designed and tested
in accordance with the EC Certificate of Conformity and has left the manufacturer’s plant in a condition
fully complying with safety standards. To maintain this condition and to ensure safe operation, observe
all instructions and warnings provided in this manual. If you have any questions regarding these safety
instructions, the Rohde & Schwarz group of companies will be happy to answer them.

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is
designed for use solely in industrial and laboratory environments or in the field and must not be used in
any way that may cause personal injury or property damage. You are responsible if the product is used
for an intention other than its designated purpose or in disregard of the manufacturer's instructions. The
manufacturer shall assume no responsibility for such use of the product.

The product is used for its designated purpose if it is used in accordance with its product documentation
and within its performance limits (see data sheet, documentation, the following safety instructions).
Using the product requires technical skills and a basic knowledge of English. It is therefore essential
that the product be used exclusively by skilled and specialized staff or thoroughly trained personnel with
the required skills. If personal safety gear is required for using Rohde & Schwarz products, this will be
indicated at the appropriate place in the product documentation.

Symbols and safety labels

. . Attention!
Observe Weight Danger of Warning! .
product indication for electric Hot PE terminal Ground ti:%ggl E;(;ti;ﬁ:at'c
documentation | units >18 kg shock surface devi
evices
| O (_l) _ TN TN D
. Device fully
s;?glﬁ Standby EL::’?GC:H Alternating Direct/alternating | protected by
ON/(?FF indication (DC) current (AC) current (DC/AC) | double/reinforced
insulation
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Safety Instructions

Observing the safety instructions will help prevent personal injury or damage of any kind caused by
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions
before putting the product into operation. It is also absolutely essential to observe the additional safety
instructions on personal safety that appear in relevant parts of the product documentation. In these
safety instructions, the word "product" refers to all merchandise sold and distributed by the Rohde &
Schwarz group of companies, including instruments, systems and all accessories.

Tags and their meaning

DANGER This tag indicates a definite hazard carrying a high risk of death or
serious injury if not avoided.

WARNING This tag indicates a possible hazard carrying a medium risk of death or
(serious) injury if not avoided.

CAUTION This tag indicates a hazard carrying a low risk of minor or moderate
injury if not avoided.

ATTENTION  This tag indicates the possibility of incorrect use that can cause damage
to the product.

NOTE This tag indicates a situation where the user should pay special attention
to operating the product but which does not lead to damage.

These tags are in accordance with the standard definition for civil applications in the European
Economic Area. Definitions that deviate from the standard definition may also exist in other economic
areas or military applications. It is therefore essential to make sure that the tags described here are
always used only in connection with the related product documentation and the related product. The
use of tags in connection with unrelated products or documentation can result in misinterpretation and
thus contribute to personal injury or material damage.

Basic safety instructions

The product may be operated only under
the operating conditions and in the
positions specified by the manufacturer. Its
ventilation must not be obstructed during
operation. Unless otherwise specified, the
following requirements apply to

Rohde & Schwarz products:

prescribed operating position is always with
the housing floor facing down, IP protection
2X, pollution severity 2, overvoltage
category 2, use only in enclosed spaces,
max. operation altitude 2000 m above sea
level, max. transport altitude 4500 m above
sea level.

Unless specified otherwise in the data
sheet, a tolerance of +10% shall apply to
the nominal voltage and of +5% to the
nominal frequency.

Applicable local or national safety
regulations and rules for the prevention of
accidents must be observed in all work
performed. The product may be opened
only by authorized, specially trained
personnel. Prior to performing any work on

1171.0000.42-03.00

the product or opening the product, the
product must be disconnected from the
supply network. Any adjustments,
replacements of parts, maintenance or
repair must be carried out only by technical
personnel authorized by Rohde & Schwarz.
Only original parts may be used for
replacing parts relevant to safety (e.g.
power switches, power transformers,
fuses). A safety test must always be
performed after parts relevant to safety
have been replaced (visual inspection, PE
conductor test, insulation resistance
measurement, leakage current
measurement, functional test).

As with all industrially manufactured goods,
the use of substances that induce an
allergic reaction (allergens, e.g. nickel)
such as aluminum cannot be generally
excluded. If you develop an allergic
reaction (such as a skin rash, frequent
sneezing, red eyes or respiratory
difficulties), consult a physician immediately
to determine the cause.
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10.

Safety Instructions

If products/components are mechanically
and/or thermically processed in a manner
that goes beyond their intended use,
hazardous substances (heavy-metal dust
such as lead, beryllium, nickel) may be
released. For this reason, the product may
only be disassembled, e.g. for disposal
purposes, by specially trained personnel.
Improper disassembly may be hazardous to
your health. National waste disposal
regulations must be observed.

If handling the product yields hazardous
substances or fuels that must be disposed
of in a special way, e.g. coolants or engine
oils that must be replenished regularly, the
safety instructions of the manufacturer of
the hazardous substances or fuels and the
applicable regional waste disposal
regulations must be observed. Also
observe the relevant safety instructions in
the product documentation.

Depending on the function, certain products
such as RF radio equipment can produce
an elevated level of electromagnetic
radiation. Considering that unborn life
requires increased protection, pregnant
women should be protected by appropriate
measures. Persons with pacemakers may
also be endangered by electromagnetic
radiation. The employer/operator is
required to assess workplaces where there
is a special risk of exposure to radiation
and, if necessary, take measures to avert
the danger.

Operating the products requires special
training and intense concentration. Make
certain that persons who use the products
are physically, mentally and emotionally fit
enough to handle operating the products;
otherwise injuries or material damage may
occur. It is the responsibility of the
employer to select suitable personnel for
operating the products.

Prior to switching on the product, it must be
ensured that the nominal voltage setting on
the product matches the nominal voltage of
the AC supply network. If a different voltage
is to be set, the power fuse of the product
may have to be changed accordingly.

In the case of products of safety class | with
movable power cord and connector,
operation is permitted only on sockets with
earthing contact and protective earth
connection.

Intentionally breaking the protective earth
connection either in the feed line or in the

1171.0000.42-03.00
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12.

13.

14.

15.

16.

17.

18.

product itself is not permitted. Doing so can
result in the danger of an electric shock
from the product. If extension cords or
connector strips are implemented, they
must be checked on a regular basis to
ensure that they are safe to use.

If the product has no power switch for
disconnection from the AC supply, the plug
of the connecting cable is regarded as the
disconnecting device. In such cases, it
must be ensured that the power plug is
easily reachable and accessible at all times
(corresponding to the length of connecting
cable, approx. 2 m). Functional or
electronic switches are not suitable for
providing disconnection from the AC
supply. If products without power switches
are integrated in racks or systems, a
disconnecting device must be provided at
the system level.

Never use the product if the power cable is
damaged. Check the power cable on a
regular basis to ensure that it is in proper
operating condition. By taking appropriate
safety measures and carefully laying the
power cable, ensure that the cable cannot
be damaged and that no one can be hurt by
e.g. tripping over the cable or suffering an
electric shock.

The product may be operated only from
TN/TT supply networks fused with max.

16 A (higher fuse only after consulting with
the Rohde & Schwarz group of companies).

Do not insert the plug into sockets that are
dusty or dirty. Insert the plug firmly and all
the way into the socket. Otherwise, this can
result in sparks, fire and/or injuries.

Do not overload any sockets, extension
cords or connector strips; doing so can
cause fire or electric shocks.

For measurements in circuits with voltages
Vims > 30V, suitable measures (e.g.
appropriate measuring equipment, fusing,
current limiting, electrical separation,
insulation) should be taken to avoid any
hazards.

Ensure that the connections with
information technology equipment comply
with IEC 950/EN 60950.

Unless expressly permitted, never remove
the cover or any part of the housing while
the product is in operation. Doing so will
expose circuits and components and can
lead to injuries, fire or damage to the
product.
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20.

21.

22.

23.

24,

25.

26.

27.

Safety Instructions

If a product is to be permanently installed,
the connection between the PE terminal on
site and the product's PE conductor must
be made first before any other connection
is made. The product may be installed and
connected only by a license electrician.

For permanently installed equipment
without built-in fuses, circuit breakers or
similar protective devices, the supply circuit
must be fused in such a way that suitable
protection is provided for users and
products.

Do not insert any objects into the openings
in the housing that are not designed for this
purpose. Never pour any liquids onto or into
the housing. This can cause short circuits
inside the product and/or electric shocks,
fire or injuries.

Use suitable overvoltage protection to
ensure that no overvoltage (such as that
caused by a thunderstorm) can reach the
product. Otherwise the operating personnel
will be endangered by electric shocks.

Rohde & Schwarz products are not
protected against penetration of water,
unless otherwise specified (see also safety
instruction 1.). If this is not taken into
account, there exists the danger of electric
shock for the user or damage to the
product, which can also lead to personal
injury.

Never use the product under conditions in
which condensation has formed or can form
in or on the product, e.g. if the product was
moved from a cold to a warm environment.

Do not close any slots or openings on the
product, since they are necessary for
ventilation and prevent the product from
overheating. Do not place the product on
soft surfaces such as sofas or rugs or
inside a closed housing, unless this is well
ventilated.

Do not place the product on heat-
generating devices such as radiators or fan
heaters. The temperature of the
environment must not exceed the maximum
temperature specified in the data sheet.

Batteries and storage batteries must not be
exposed to high temperatures or fire. Keep
batteries and storage batteries away from
children. Do not short-circuit batteries and
storage batteries.

If batteries or storage batteries are
improperly replaced, this can cause an
explosion (warning: lithium cells). Replace

1171.0000.42-03.00

28.

29.

30.

31.

32.

33.

the battery or storage battery only with the
matching Rohde & Schwarz type (see
spare parts list). Batteries and storage
batteries must be recycled and kept
separate from residual waste. Batteries and
storage batteries that contain lead, mercury
or cadmium are hazardous waste. Observe
the national regulations regarding waste
disposal and recycling.

Please be aware that in the event of a fire,
toxic substances (gases, liquids etc.) that
may be hazardous to your health may
escape from the product.

The product can be very heavy. Be careful
when moving it to avoid back or other
physical injuries.

Do not place the product on surfaces,
vehicles, cabinets or tables that for reasons
of weight or stability are unsuitable for this
purpose. Always follow the manufacturer's
installation instructions when installing the
product and fastening it to objects or
structures (e.g. walls and shelves).

Handles on the products are designed
exclusively for personnel to hold or carry
the product. It is therefore not permissible
to use handles for fastening the product to
or on means of transport such as cranes,
fork lifts, wagons, etc. The user is
responsible for securely fastening the
products to or on the means of transport
and for observing the safety regulations of
the manufacturer of the means of transport.
Noncompliance can result in personal injury
or material damage.

If you use the product in a vehicle, it is the
sole responsibility of the driver to drive the
vehicle safely. Adequately secure the
product in the vehicle to prevent injuries or
other damage in the event of an accident.
Never use the product in a moving vehicle if
doing so could distract the driver of the
vehicle. The driver is always responsible for
the safety of the vehicle. The manufacturer
assumes no responsibility for accidents or
collisions.

If a laser product (e.g. a CD/DVD drive) is
integrated in a Rohde & Schwarz product,
do not use any other settings or functions
than those described in the product
documentation. Otherwise this may be
hazardous to your health, since the laser
beam can cause irreversible damage to
your eyes. Never try to take such products
apart, and never look into the laser beam.
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Informaciones de seguridad

Por favor lea imprescindiblemente antes de
la primera puesta en funcionamiento las
siguientes

Informaciones de seguridad

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al
dia con los estandards de seguridad y de ofrecer a nuestros clientes el maximo grado de seguridad.
Nuestros productos y todos los equipos adicionales son siempre fabricados y examinados segun las
normas de seguridad vigentes. Nuestra seccion de gestién de la seguridad de calidad controla
constantemente que sean cumplidas estas normas. El presente producto ha sido fabricado y
examinado segun el comprobante de conformidad adjunto segun las normas de la CE y ha salido de
nuestra planta en estado impecable segun los estandards técnicos de seguridad. Para poder preservar
este estado y garantizar un funcionamiento libre de peligros, el usuario debera atenerse a todas las
informaciones, informaciones de seguridad y notas de alerta. El grupo de empresas Rohde & Schwarz
esta siempre a su disposicion en caso de que tengan preguntas referentes a estas informaciones de
seguridad.

Ademas queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto
solamente fue elaborado para ser utilizado en la industria y el laboratorio o para fines de campo y de
ninguna manera debera ser utilizado de modo que alguna persona/cosa pueda ser danada. El uso del
producto fuera de sus fines definidos o despreciando las informaciones de seguridad del fabricante
queda en la responsabilidad del usuario. El fabricante no se hace en ninguna forma responsable de
consecuencias a causa del mal uso del producto.

Se parte del uso correcto del producto para los fines definidos si el producto es utilizado dentro de las
instrucciones de la correspondiente documentacion de producto y dentro del margen de rendimiento
definido (ver hoja de datos, documentacion, informaciones de seguridad que siguen). El uso del
producto hace necesarios conocimientos profundos y conocimientos parciales del idioma inglés. Por
eso se debera tener en cuenta de exclusivamente autorizar para el uso del producto a personas peritas
0 debidamente minuciosamente instruidas con los conocimientos citados. Si fuera necesaria
indumentaria de seguridad para el uso de productos de R&S, encontrara la informacion debida en la
documentacién del producto en el capitulo correspondiente.

Simbolos y definiciones de seguridad

1

A & A L

i

. jCuidado!
Informaciones I
Ver . . iy L L Elementos de
para Peligro de jAdvertencia! | Conexion a . Conexion >
documen- I g Conexion construccion
. maquinaria golpe de Superficie conductor ; a masa )
tacion de . ) atierra con peligro de
con uns peso corriente caliente protector conductora
producto carga
de > 18kg

electroestatica

| O (D — ~ _ O

El aparato esta

. S Corriente . Corriente protegido en su
potencia EN Indicacion continua Corriente continua/alterna | totalidad por un
MARCHA/PARADA | Stand-by DC alterna AC DC/AC aislamiento de

doble refuerzo
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Informaciones de seguridad

Tener en cuenta las informaciones de seguridad sirve para tratar de evitar dafos y peligros de toda
clase. Es necesario de que se lean las siguientes informaciones de seguridad concienzudamente y se
tengan en cuenta debidamente antes de la puesta en funcionamiento del producto. También deberan
ser tenidas en cuenta las informaciones para la proteccion de personas que encontraran en el capitulo
correspondiente de la documentacién de producto y que también son obligatorias de seguir. En las
informaciones de seguridad actuales hemos juntado todos los objetos vendidos por el grupo de
empresas Rohde & Schwarz bajo la denominacidon de ,producto®, entre ellos también aparatos,
instalaciones asi como toda clase de accesorios.

Palabras de seial y su significado

PELIGRO Identifica un peligro directo con riesgo elevado de provocar muerte o

lesiones de gravedad si no se toman las medidas oportunas.

ADVERTENCIA Identifica un posible peligro con riesgo medio de provocar muerte o
lesiones (de gravedad) si no se toman las medidas oportunas.

ATENCION Identifica un peligro con riesgo reducido de provocar lesiones de
gravedad media o leve si no se toman las medidas oportunas.
CUIDADO Indica la posibilidad de utilizar mal el producto y a consecuencia

danarlo.

INFORMACION Indica una situacién en la que deberian seguirse las instrucciones en el
uso del producto, pero que no consecuentemente deben de llevar a un
dafio del mismo.

Las palabras de sefial corresponden a la definicion habitual para aplicaciones civiles en el area
econdmica europea. Pueden existir definiciones diferentes a esta definicion en otras areas econémicas
o en aplicaciones militares. Por eso se debera tener en cuenta que las palabras de sefial aqui descritas
sean utilizadas siempre solamente en combinacién con la correspondiente documentacién de producto
y solamente en combinacion con el producto correspondiente. La utilizacién de las palabras de seial
en combinacién con productos o documentaciones que no les correspondan puede llevar a
malinterpretaciones y tener por consecuencia dafios en personas u objetos.

Informaciones de seguridad elementales

El producto solamente debe ser utilizado
segun lo indicado por el fabricante referente
a la situacion y posicion de funcionamiento
sin que se obstruya la ventilacion. Si no se
convino de otra manera, es para los
productos R&S valido lo que sigue:

como posicién de funcionamiento se define
principialmente la posicion con el suelo de la
caja para abajo , modo de proteccion IP 2X,
grado de suciedad 2, categoria de
sobrecarga eléctrica 2, utilizar solamente en
estancias interiores, utilizacién hasta 2000 m
sobre el nivel del mar, transporte hasta
4.500 m sobre el nivel del mar.

A menos que se especifique otra cosa en la
hoja de datos, se aplicara una tolerancia de
1+10% sobre el voltaje nominal y de +5%
sobre la frecuencia nominal.

En todos los trabajos deberan ser tenidas en
cuenta las normas locales de seguridad de

1171.0000.42-03.00

trabajo y de prevencion de accidentes. El
producto solamente debe de ser abierto por
personal perito autorizado. Antes de efectuar
trabajos en el producto o abrirlo debera este
ser desconectado de la corriente. El ajuste,
el cambio de partes, la manutencion y la
reparacion deberan ser solamente
efectuadas por electricistas autorizados por
R&S. Si se reponen partes con importancia
para los aspectos de seguridad (por ejemplo
el enchufe, los transformadores o los
fusibles), solamente podran ser sustituidos
por partes originales. Despues de cada
recambio de partes elementales para la
seguridad debera ser efectuado un control de
seguridad (control a primera vista, control de
conductor protector, mediciéon de resistencia
de aislamiento, medicién de medicion de la
corriente conductora, control de
funcionamiento).
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Informaciones de seguridad

Como en todo producto de fabricacién
industrial no puede ser excluido en general
de que se produzcan al usarlo elementos
que puedan generar alergias, los llamados
elementos alergénicos (por ejemplo el
niquel). Si se producieran en el trato con
productos R&S reacciones alérgicas, como
por ejemplo urticaria, estornudos frecuentes,
irritacion de la conjuntiva o dificultades al
respirar, se debera consultar inmediatamente
a un médico para averigurar los motivos de
estas reacciones.

Si productos / elementos de construcciéon son
tratados fuera del funcionamiento definido de
forma mecanica o térmica, pueden generarse
elementos peligrosos (polvos de sustancia
de metales pesados como por ejemplo
plomo, berilio, niquel). La particion elemental
del producto, como por ejemplo sucede en el
tratamiento de materias residuales, debe de
ser efectuada solamente por personal
especializado para estos tratamientos. La
particion elemental efectuada
inadecuadamente puede generar dafios para
la salud. Se deben tener en cuenta las
directivas nacionales referentes al
tratamiento de materias residuales.

En el caso de que se produjeran agentes de
peligro o combustibles en la aplicacion del
producto que debieran de ser transferidos a
un tratamiento de materias residuales, como
por ejemplo agentes refrigerantes que deben
ser repuestos en periodos definidos, o
aceites para motores, deberan ser tenidas en
cuenta las prescripciones de seguridad del
fabricante de estos agentes de peligro o
combustibles y las regulaciones regionales
para el tratamiento de materias residuales.
Cuiden también de tener en cuenta en caso
dado las prescripciones de seguridad
especiales en la descripcion del producto.

Ciertos productos, como por ejemplo las
instalaciones de radiacion HF, pueden a
causa de su funcion natural, emitir una
radiacion electromagnética aumentada. En
vista a la proteccién de la vida en desarrollo
deberian ser protegidas personas
embarazadas debidamente. También las
personas con un bypass pueden correr
peligro a causa de la radiacion
electromagnética. El empresario/usario esta

1171.0000.42-03.00

10.

1.

comprometido a valorar y sefialar areas de
trabajo en las que se corra un riesgo
aumentado de exposicion a radiaciones para
evitar riesgos.

La utilizacion de los productos requiere
instrucciones especiales y una alta
concentracién en el manejo. Debe de
ponerse por seguro de que las personas que
manejen los productos estén a la altura de
los requerimientos necesarios referente a
sus aptitudes fisicas, psiquicas y
emocionales, ya que de otra manera no se
pueden excluir lesiones o dafos de objetos.
El empresario lleva la responsabilidad de
seleccionar el personal usuario apto para el
manejo de los productos.

Antes de la puesta en marcha del producto
se deberd tener por seguro de que la tension
preseleccionada en el producto equivalga a
la del la red de distribucion. Si es necesario
cambiar la preseleccion de la tension
también se deberan en caso dabo cambiar
los fusibles correspondientes del prodcuto.

Productos de la clase de seguridad | con
alimentacion movil y enchufe individual de
producto solamente deberan ser conectados
para el funcionamiento a tomas de corriente
de contacto de seguridad y con conductor
protector conectado.

Queda prohibida toda clase de interrupcion
intencionada del conductor protector, tanto
en la toma de corriente como en el mismo
producto. Puede tener como consecuencia el
peligro de golpe de corriente por el producto.
Si se utilizaran cables o enchufes de
extension se debera poner al seguro, que es
controlado su estado técnico de seguridad.

Si el producto no esta equipado con un
interruptor para desconectarlo de la red, se
debera considerar el enchufe del cable de
distribucion como interruptor. En estos casos
debera asegurar de que el enchufe sea de
facil acceso y nabejo (segun la medida del
cable de distribucion, aproximadamente

2 m). Los interruptores de funcién o
electronicos no son aptos para el corte de la
red eléctrica. Si los productos sin interruptor
estan integrados en construciones o
instalaciones, se debera instalar el interruptor
al nivel de la instalacion.
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12. No utilice nunca el producto si esta dafado el

13.

14.

15.

16.

17.

18.

19.

Informaciones de seguridad

cable eléctrico. Compruebe regularmente el
correcto estado de los cables de conexion a
red. Asegure a través de las medidas de
proteccion y de instalacion adecuadas de
que el cable de eléctrico no pueda ser
dafado o de que nadie pueda ser dafiado
por él, por ejemplo al tropezar o por un golpe
de corriente.

Solamente esta permitido el funcionamiento
en redes de distribucion TN/TT aseguradas
con fusibles de como maximo 16 A
(utilizacion de fusibles de mayor amperaje
s6lo previa consulta con el grupo de
empresas Rohde & Schwarz).

Nunca conecte el enchufe en tomas de
corriente sucias o llenas de polvo. Introduzca
el enchufe por completo y fuertemente en la
toma de corriente. Si no tiene en
consideracion estas indicaciones se arriesga
a que se originen chispas, fuego y/o heridas.

No sobrecargue las tomas de corriente, los
cables de extension o los enchufes de
extension ya que esto pudiera causar fuego
0 golpes de corriente.

En las mediciones en circuitos de corriente
con una tension de entrada de U > 30 V se
debera tomar las precauciones debidas para
impedir cualquier peligro (por ejemplo
medios de medicién adecuados, seguros,
limitacion de tension, corte protector,
aislamiento etc.).

En caso de conexion con aparatos de la
técnica informatica se debera tener en
cuenta que estos cumplan los requisitos de
la EC950/EN60950.

A menos que esté permitido expresamente,
no retire nunca la tapa ni componentes de la
carcasa mientras el producto esté en
servicio. Esto pone a descubierto los cables
y componentes eléctricos y puede causar
heridas, fuego o dafios en el producto.

Si un producto es instalado fijamente en un
lugar, se debera primero conectar el
conductor protector fijo con el conductor
protector del aparato antes de hacer
cualquier otra conexion. La instalacion y la
conexion deberan ser efecutadas por un
electricista especializado.

1171.0000.42-03.00

20.

22.

23.

24.

25.

26.

En caso de que los productos que son
instalados fijamente en un lugar sean sin
protector implementado, autointerruptor o
similares objetos de proteccidn, el circuito de
suministro de corriente debera estar
protegido de manera que usuarios y
productos estén suficientemente protegidos.

. Por favor, no introduzca ninguin objeto que

no esté destinado a ello en los orificios de la
caja del aparato. No vierta nunca ninguna
clase de liquidos sobre o en la caja. Esto
puede producir corto circuitos en el producto
y/o puede causar golpes de corriente, fuego
o heridas.

Asegurese con la proteccion adecuada de
que no pueda originarse en el producto una
sobrecarga por ejemplo a causa de una
tormenta. Si no se vera el personal que lo
utilice expuesto al peligro de un golpe de
corriente.

Los productos R&S no estan protegidos
contra el agua si no es que exista otra
indicacion, ver también punto 1. Si no se
tiene en cuenta esto se arriesga el peligro de
golpe de corriente para el usario o de dafios
en el producto lo cual también puede llevar al
peligro de personas.

No utilice el producto bajo condiciones en las
que pueda producirse y se hayan producido
liquidos de condensaciéon en o dentro del
producto como por ejemplo cuando se
desplaza el producto de un lugar frio a un
lugar caliente.

Por favor no cierre ninguna ranura u orificio
del producto, ya que estas son necesarias
para la ventilacién e impiden que el producto
se caliente demasiado. No pongan el
producto encima de materiales blandos como
por ejemplo sofas o alfombras o dentro de
una caja cerrada, si esta no esta
suficientemente ventilada.

No ponga el producto sobre aparatos que
produzcan calor, como por ejemplo
radiadores o calentadores. La temperatura
ambiental no debe superar la temperatura
maxima especificada en la hoja de datos.
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27.

28.

20.

30.

Informaciones de seguridad

Baterias y acumuladores no deben de ser
expuestos a temperaturas altas o al fuego.
Guardar baterias y acumuladores fuera del
alcance de los nifios. No cortocircuitar
baterias ni acumuladores. Si las baterias o
los acumuladores no son cambiados con la
debida atencidn existira peligro de explosion
(atencion celulas de Litio). Cambiar las
baterias o los acumuladores solamente por
los del tipo R&S correspondiente (ver lista de
piezas de recambio). Las baterias y
acumuladores deben reutilizarse y no deben
acceder a los vertederos. Las baterias y
acumuladores que contienen plomo,
mercurio o cadmio deben tratarse como
residuos especiales. Respete en esta
relacion las normas nacionales de
evacuacion y reciclaje.

Por favor tengan en cuenta que en caso de
un incendio pueden desprenderse del
producto agentes venenosos (gases, liquidos
etc.) que pueden generar dafios a la salud.

El producto puede poseer un peso elevado.
Muévalo con cuidado para evitar lesiones en
la espalda u otras partes corporales.

No situe el producto encima de superficies,
vehiculos, estantes 0 mesas, que por sus
caracteristicas de peso o de estabilidad no
sean aptas para él. Siga siempre las
instrucciones de instalacion del fabricante
cuando instale y asegure el producto en
objetos o estructuras (por ejemplo paredes y
estantes).

1171.0000.42-03.00

31.

32.

33.

Las asas instaladas en los productos sirven
solamente de ayuda para el manejo que
solamente esta previsto para personas. Por
€so no esta permitido utilizar las asas para la
sujecion en o sobre medios de transporte
como por ejemplo gruas, carretillas
elevadoras de horquilla, carros etc. El
usuario es responsable de que los productos
sean sujetados de forma segura a los medios
de transporte y de que las prescripciones de
seguridad del fabricante de los medios de
transporte sean tenidas en cuenta. En caso
de que no se tengan en cuenta pueden
causarse dafios en personas y objetos.

Si llega a utilizar el producto dentro de un
vehiculo, queda en la responsabilidad
absoluta del conductor que conducir el
vehiculo de manera segura. Asegure el
producto dentro del vehiculo debidamente
para evitar en caso de un accidente las
lesiones u otra clase de dafios. No utilice
nunca el producto dentro de un vehiculo en
movimiento si esto pudiera distraer al
conductor. Siempre queda en la
responsabilidad absoluta del conductor la
seguridad del vehiculo. El fabricante no
asumira ninguna clase de responsabilidad
por accidentes o colisiones.

Dado el caso de que esté integrado un
producto de laser en un producto R&S (por
ejemplo CD/DVD-ROM) no utilice otras
instalaciones o funciones que las descritas
en la documentacién de producto. De otra
manera pondra en peligro su salud, ya que el
rayo laser puede daiar irreversiblemente sus
ojos. Nunca trate de descomponer estos
productos. Nunca mire dentro del rayo laser.
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Certified Quality System

DIN EN ISO 9001

DIN EN

QUALITATSZERTIFIKAT

Sehr geehrter Kunde,

Sie haben sich fir den Kauf eines
Rohde & Schwarz-Produktes entschie-
den. Hiermit erhalten Sie ein nach
modernsten Fertigungsmethoden
hergestelltes Produkt. Es wurde nach
den Regeln unseres Management-
systems entwickelt, gefertigt und
gepruft.

Das Rohde & Schwarz Management-
system ist zertifiziert nach:

DIN EN SO 9001:2000
DIN EN 9100:2003
DIN EN ISO 14001:1996

9100
DIN EN 1SO 14001

DAS REG. NO 001954 QM/ST UM

CERTIFICATE OF QUALITY

Dear Customer,

you have decided to buy a Rohde &
Schwarz product. You are thus as-
sured of receiving a product that is
manufactured using the most modern
methods available. This product was
developed, manufactured and tested
in compliance with our quality manage-
ment system standards.

The Rohde & Schwarz quality manage-
ment system is certified according to:

DIN EN IS0 9001:2000
DIN EN 9100:2003
DIN EN ISO 14001:1996

CERTIFICAT DE QUALITE

Cher Client,

vous avez choisi d'acheter un produit
Rohde & Schwarz. Vous disposez
donc d'un produit fabriqué d‘apres
les méthodes les plus avancées. Le
développement, la fabrication et les
tests respectent nos normes de ges-
tion qualité.

Le systéme de gestion qualité de
Rohde & Schwarz a été homologué
conformément aux normes:

DIN EN 1SO 9001:2000
DIN EN 9100:2003
DIN EN ISO 14001:1996

ROHDE&SCHWARZ

1171.0200.11-01.00






Customer Support

Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz equipment, contact one of our
Customer Support Centers. A team of highly qualified engineers provides telephone
support and will work with you to find a solution to your query on any aspect of the
operation, programming or applications of Rohde & Schwarz equipment.

Up-to-date information and upgrades

To keep your Rohde & Schwarz equipment always up-to-date,
please subscribe to our electronic newsletter at

http://www.rohde-schwarz.com/www/response.nsf/newsletterpreselection

or request the desired information and upgrades via email from your Customer Support
Center (addresses see below).

Feedback

We want to know if we are meeting your support needs. If you have any comments
please email us and let us know CustomerSupport.Feedback@rohde-schwarz.com.

USA & Canada Monday to Friday (except US public holidays)

8:00 AM — 8:00 PM Eastern Standard Time (EST)

Tel. from USA 888-test-rsa (888-837-8772) (opt 2)

From outside USA +1 410 910 7800 (opt 2)

Fax +1 410 910 7801

E-mail Customer.Support@rsa.rohde-schwarz.com
East Asia Monday to Friday (except Singaporean public holidays)

8:30 AM - 6:00 PM Singapore Time (SGT)

Tel. +65 6 513 0488

Fax +65 6 846 1090

E-mail Customersupport.asia@rohde-schwarz.com

Rest of the World Monday to Friday (except German public holidays)
08:00 — 17:00 central European Time (CET)

Tel. from Europe +49 (0) 180 512 42 42
From outside Europe +49 89 4129 13776
Fax +49 (0) 89 41 29 637 78

E-mail CustomerSupport@rohde-schwarz.com

&

ROHDE & SCHWARZ

1171.0200.22-01.00
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Address List

Headquarters, Plants and Subsidiaries

Headquarters

ROHDE& SCHWARZ GmbH & Co. KG
Miihldorfstrafe 15 - D-81671 Minchen
P.0.Box 80 14 69 - D-81614 Miinchen

Plants

ROHDE& SCHWARZ Messgeratebau GmbH
RiedbachstraRe 58 - D-87700 Memmingen
P.0.Box 16 52 - D-87686 Memmingen

ROHDE& SCHWARZ GmbH & Co. KG

Werk Teisnach

Kaikenrieder Strae 27 - D-94244 Teisnach
P.0.Box 1149 - D-94240 Teisnach

ROHDE&SCHWARZ zavod
Vimperk, s.r.o.

Location Spidrova 49
(CZ-38501 Vimperk

ROHDE&SCHWARZ GmbH & Co. KG
Dienstleistungszentrum Kéln
Graf-Zeppelin-StraBe 18 - D-51147 KdlIn
P.0.Box 98 02 60 - D-51130 KéIn

Subsidiaries

R&S BICK Mabilfunk GmbH
Fritz-Hahne-Str. 7 - D-31848 Bad Minder
P.0.Box 20 02 - D-31844 Bad Miinder

ROHDE& SCHWARZ FTK GmbH
WendenschloRstraRe 168, Haus 28
D-12557 Berlin

ROHDE& SCHWARZ SIT GmbH
Am Studio 3
D-12489 Berlin

R&S Systems GmbH
Graf-Zeppelin-StraRe 18
D-51147 KéIn

GEDIS GmbH
Sophienblatt 100
D-24114 Kiel

HAMEG Instruments GmbH

Industriestrale 6
D-63533 Mainhausen

1171.0200.42-02.00

Phane +49 (89) 41 29-0
Fax +49 (89) 41 29-121 64
info.rs@rohde-schwarz.com

Phone +49 (83 31) 1 08-0
+49(8331) 108-1124
info.rsmb@rohde-schwarz.com

Phone +49 (99 23) 8 50-0
Fax +49 (99 23) 8 50-174
info.rsdts@rohde-schwarz.com

Phone +420 (388) 45 21 09
Fax +420 (388) 45 21 13

Phane +49 (22 03) 49-0

Fax +49 (22 03) 49 51-229
info.rsdc@rohde-schwarz.com
service.rsdc@rohde-schwarz.com

Phone +49 (50 42) 9 98-0
Fax +49 (50 42) 9 98-105
info.bick@rohde-schwarz.com

Phone +49 (30) 658 91-122
Fax +49 (30) 655 50-221
info.ftk@rohde-schwarz.com

Phone +49 (30) 658 84-0
Fax +49 (30) 658 84-183
info.sit@rohde-schwarz.com

Phone +49 (22 03) 49-5 23 25
Fax +49 (22 03) 49-5 23 36
info.rssys@rohde-schwarz.com

Phone +49 (431) 600 51-0
Fax +49 (431) 600 51-11
sales@gedis-online.de

Phone +49 (61 82) 800-0
Fax +49 (61 82) 800-100
info@hameg.de

Locations Worldwide

Please refer to our homepage: www.rohde-schwarz.com

@ Sales Locations
@ Service Locations
# National Websites






1 Overview
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Acoustic Measurements on Hearing Aids

Tests of basic properties of hearing aids are specified in standards
IEC 60118 and ANSI S3.22. They comprise measurement of output sound
pressure level, frequency responses, output SPL over input SPL, harmonic
distortion, battery current drain and AGC settling.

Audio Analyzer R&S UPV with option R&S UPV-K7 provides a test system
which, together with the necessary acoustic accessories, allows
measurements according to IEC60118-0:1983, IEC60118-1:1995, IEC60118-
2:1983, IEC60118-7:2005 and ANSI S3.22-2003.

In addition to standard measurements it is possible to create own tests by
customizing the available parameters.

Automatic test sequences can be compiled from the available tests, and
results are compiled for subsequent creation of test reports.



Acoustic Measurements on Hearing Aids

2 Preparation and Start of the Application Software

1401.9353.12-01

Required Measuring Instruments and Accessories
The Audio Analyzer R&S UPV with option R&S UPV-K7 is required for the
measurements.

Acoustic devices such as measurement couplers, a calibrator and other
accessories are required for the measurements. The following equipment

from Briel & Kjeer or G.R.A.S. may be used:

Device

Description

Type (examples)

Hearing aid test box

Anechoic box with built-in sound
source and induction loop, feed-
throughs for the most important
connection lines

R&S UPL-B7 or
Interacoustics
TBS25 or B&K 4232

Measurement microphone

4" measurement microphone for
measurement of artificial mouth
output during calibration, to be
inserted into IEC 126 2cc coupler,
and for comparison measurement

B&K 4938 with B&K
2670 or G.R.A.S.
40BP with G.R.A.S.
26AC

IEC 126 coupler

Acoustic coupler according to
IEC 126

Part of R&S UPL-B7
(with internal
microphone or with
4" microphone with
preamplifier)

IEC 711 ear simulator IEC 711 type occluded ear simulator | B&K 4157 & 2669
(optional) with adapters for calibration and
connection to the output of the DUT,
with 1/2” - preamplifier
Acoustic calibrator Sound level calibrator or B&K 4231 or
pistonphone for calibrating the G.R.A.S. 42AB

measuring microphones

Microphone power supply

Power supply and preamplifier for
the measuring microphone

B&K 2829, 5935L or
2690A0S2

or G.R.A.S. 12AD or
12AA

Note: With the amplifier set to 0 dB, the microphone power supply
B&K 2690A0S2 produces too much noise for measuring idle
noise and distortion. It is therefore advisable to set a gain of

20 dB.

Theoretically the reference microphone for sound source
calibration and comparison measurement should be a free field
type and the IEC 126 coupler should be used with a pressure
field type. However with a 4” microphone the frequency
response difference is negligible up to at least 10 kHz.

An external USB keyboard and a mouse must be connected to

the R&S UPV.
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Acoustic Measurements on Hearing Aids

Caution: R&S UPV-K7 does not support the use of headphones. Do not
connect headphones to the R&S UPV during hearing aid tests.
High level signals may be present at the headphone connector.

The program required and the associated files are in the folder “UPV-K7
Software” on the installation CD supplied with the R&S UPV-K7 option. The
audio analyzer must meet the following firmware requirements:

¢ R&S UPV firmware version 2.0.0 or higher
e Option R&S UPV-K7 installed

Installing the Software

The application program requires option key K7 to be installed. The key is
installed in the factory in case a new R&S UPV is ordered together with this
option. If the option is ordered separately, the key as well as the installation
manual is part of the delivery.

It is recommended to copy the files UPV-K7.msi, Config.ini, dotnetfx.exe,
Setup.Exe and Settings.Ini from the folder “UPV-K7 Software” on the
installation CD to drive D: on the R&S UPV hard disk drive, e.g. to a folder
named “D:\R&S Software\UPV-K7\Version 1.0”. Run the file “Setup.Exe” to
start the installation. Follow the instructions of the installer on the screen.

Test Setup

ANLG AUX OUT

T Microphone
= } l Power Supply

ot Wi o Y s et
= .

Audio Analyzer

R&S UPV |-

in

oupler Cable
/

() e o e e e}

Battery Adaptor Cable

Loudspeaker Cable —

Telecoil Cable Ll

Acoustical Test Box

Fig. 1 Test setup and connection of external components

The following cables are required to connect speaker, induction loop and
battery voltage supply of the test box delivered with R&S UPL-B7 to the
R&S UPV. The microphone signal from the microphone power supply may
be connected to the analyzer input with a BNC cable and a R&S UPL-Z1
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Acoustic Measurements on Hearing Aids

adapter. If a custom made BNC to XLR cable is used, it should be made
following the schematics of the R&S UPL-Z1 adapter (see R&S UPV
manual, chapter “Configuring the Analog Analyzer”).

XLR female
e open ends
3
2
- —
Loudspeaker Cable
XLR female
3—‘\ 6.3 mm mono jack male
2| = >z == < D
.
Telecoil Cable
XLR male 3.5 mm stereo jack male
I _
3 __—===F====== 5y
R1 D ==
2

D: 4 diodes: 1N4007 or similar (1A foreward current)
R1: resistor 2 Ohm, 1% BNC male
R2: 2 resistors 1 Ohm, 1%

Battery Adaptor Cable

Fig. 2 Connection cables for R&S UPL-B7 (Interacoustics TBS 25) test
box

The cables of R&S UPL-B7 can be re-used for R&S UPV-K7. As the supply
voltage is now provided by the “ANLG AUX OUT” on the rear panel of the
R&S UPV, the following adapter is required in addition.

6.3 mm stereo jack female BNC male

Fig. 3 Adapter cable to connect the R&S UPL-B7 battery supply cable
to the “ANLG AUX OUT” of the R&S UPV

1401.9353.12-01 8 E-1
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Starting the Application Software

After installation, the program can be started by double-clicking the lcon
“UPV-K7 Hearing Aid Tests” or by clicking “R&S UPV Applications > UPV-
K7 Hearing Aid Tests” in the “Programs” menu.

At the fist start of the program, selection windows appear for the standard
according to which the measurements should be made, and for the
measurement coupler used.

The entered selections are stored with the settings and automatically
loaded at the next start of the program.

At each start of the program, the ambient conditions temperature, relative
humidity and atmospheric pressure are queried for protocol purpose. The
entered values are not stored in the settings, because the ambient
conditions are supposed to change with time. The query can be deselected
and values can be changed any time in the “Options” menu.

Select Standard

none

[EC1158-0.1. 2

[EC118-7

AMSI 5322

r AllEwr ol standarnd
MEasUremnents

[T Do ot show this dislog again

Cancel | Ok

o

Fig. 4 Query window for selection of applied standard

If “none” is selected in the standard selection window, all measurements
appear in the “Measurement” menu. If a standard is selected, all
measurements appear in the “Measurement” menu, but compliant
measurements are checked in the menu. If “Allow only standard
measurements” is checked, non-compliant measurements are suppressed
in the Measurement menu.
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Select Ear Simulator

[EC 126

[EC 711

[T D not show this dislog again

Cancel | Ok I
y

Fig. 5 Query window for selection of ear simulator

When the checkbox “Do not show this dialog again” is checked, the
corresponding selection window will not appear at the program start in
future. However, the selection is still available in the “Options” menu (see
below).

The next window to open is the input window for the ambient conditions
temperature, relative humidity and atmospheric pressure.

Ambient Conditions

Temperature
L
Felative hurmidity

[ 00 %

Atmospheric pressure

| 0.0 |kFa =]
Cancel | Ok I/

o

Fig. 6 Query window for input of ambient conditions

The units can be switched between °C and °F and between kPa and
mmHg, respectively. After the last of the three selection windows has been
closed, the main window of the R&S UPV-K7 opens.

1401.9353.12-01 10 E-1
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@)Hearing Aid Tests =] E3 |

File Data Calbration Measurement Sequence Report Options Help

Test Results Overvew
Date and Time: | Measurement Title | Test Object |Vardi | Comment

4 »
!
Mo Stendard  IEC126 Substituion | | 1.500Y
Fepartast Feportlast Esit
heasirenest SEQUERICE!

Fig. 7 Main window after first start of the program

Initially the data grid in the centre of the screen which shows the result
overview is empty. The screenshot below shows an example after a
number of measurements have been made.

[OHearing idTests _____ _____ ___________ mEH|

File Data Calibration Measurement Sequence Report ©Options  Help

TestRResults Dverview

Date and Time | Measurement Title ‘ Test Object | Verdi ‘ Comment =
4 10/26/2006 6:43:.05PM | OSPLI0(IEC] FalL
10/26/2006 6:43:46 P |Full-On Gain 50 dB [IEC] FalL
10/26/2006 B:44:13 P Reference Test Setting [IEC] PASS
10/26/2006 B:45:23 P Field of Frequency Responsze Curves{|EC) PASS f
10/26/2006 B:45:52 PM Dwnarnic Behaviour [IEC) FAIL
10/26/2006 B:46:07 PM Input - Output Characteristics (IEC) PASS
10/26/2006 B:46:45 PM Equirvalent Input Naise 1/3 oct. [IEC) PASS
11/7/2006 4:56:57 P OSPL30 (IEC-7) FalL
11/7/2006 4:58:41 PM OSPL30 (IEC-7) FalL
11/7/2006 5:05:39 PM O5PLI0(IEC-7) FAIL
11/7/2006 5:07.56 PM O5PLI0(IEC-7) FalL
11/7/2006 5:27.44 PM O5PLI0(IEC-7) FalL
11/7/2006 5:31:42 PM O5PLI0(IEC-7) FalL
11/7/2006 5:37.20 PM O5PLI0(IEC-7) FaIL
11/27/2006 350:43 P |Full-On Gain 50 dB [IEC] FalL
1142772006 4:23:22 PM Battery Curent [Generic] PASS
11/27/2006 4:52:35 P | Biattery Current (IEC) PASS
11/27/2006 5:00:35 P | Biattery Curtent (IEC) PASS
11/27 /2006 5:01:36 PM Battery Curent [IEC) PASS
11/27 /2006 5:05:02 PM Battery Curent [IEC) PASS
121./2006 10:06:57 AM Battery Cunent [Generic) FAIL
121./2006 1:29.53 Pt Battery Cunent [Generic] PASS
121/20061:34.11 P Battery Cunent [Generic] PASS
12/1/2006 1:46:27 Pt Battery Cunent [Generic) PASS
121/2008 21325 PM Harmonic Distortion [Generic) FAIL
1241/2008 2:20:21 PM Harmonic Distortion [Generic) FAIL =
17 M ONE 7771 4 Dhd Ul corecmavien it 172 mwmriedd can
| | DI
[NoStandard  [IEC 128 Substituion [ather 1.500Y
| Report lazt Feport &zt | Eqit |
measuiement SEqUERCE
Fig. 8 Main window with results
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3 Operating Concept

1401.9353.12-01

Options (General settings)

nt Sequence  Report | Options  Help
_ Continuaus current measuremenk
Meazuremeant Title Measurement Frequency range
High pass (rurmble] Filker

Low pass (hiss noise) Filker

Adaptive measurement (function settling)
Standard
v Seleck skandard at skarkup
Ear Sirnulator
v Seleck ear simulator at skarkup
Armbient conditions
v Query ambient conditions at skarkup
Test method
v Use coupler mic as reference mic
v Show operator instructions
v Store results of Further measurements
Battery voltage
Report setkings

Fig. 9 Options menu

The “Options” menu in the main window allows to change a set of general
settings like ear simulator, test method and battery voltage, which are valid
for all or at least a plurality of the tests.

“Continuous current measurement” allows to measure the supply
current at analyzer input 2. This option can only be selected with the
substitution method. The value of the shunt resistor for the current
measurement can be entered in the calibration menu. By default it is set to
20Q.

“Measurement frequency range” allows to enter the frequency range in
which the sound source is calibrated. In general this will be 100 Hz to
10 kHz which is the default. “Number of points” specifies the number of
(logarithmically spaced) frequencies measured for the sound source
equalization.

“High pass (rumble) filter” allows to set a high pass filter which is active
in most measurements except distortion measurements, battery current
measurements and noise measurements. The edge frequency of the high
pass filter can be set, and the filter can be activated and deactivated. The
high pass filter is not applied to battery current measurements.

“Low pass (hiss noise) filter” allows to set a low pass filter which is active
in most measurements except battery current measurements and noise
measurements. The edge frequency of the high pass filter can be set, and
the filter can be activated and deactivated. The low pass filter is not applied
to battery current and distortion measurements.

12 E-1
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With noise measurements, the filters from the “Options” menu are only
applied to the gain measurement. The noise measurement has own
parameters for the band limits of the noise level measurement.

Note: Filters slow down the measurement. Therefore they should only
be used if necessary. In particular a combination of selective
measurement with high pass and / or low pass filter is not
recommended.

“Adaptive measurement (function settling)” causes gain and level
measurements to be repeated until the result has settled within a specified
tolerance. This is helpful to assure that an AGC which is present in the
signal path has adapted to the applied input signal of the hearing aid.

> settling =]

¥ Active
Type

" Exponential % Flat

Samples I@
Tolerance Im %
Resoution [ 40.0—=] dBSPL
Tirmeout Im 5

Cancel | Ok I
¥

Fig. 10 Input window for adaptive measurement

With the “Flat” type, measurements are repeated until the last “Samples”
number of results are within the given “Tolerance” or the difference
between two subsequent measurement results is below the “Resolution”
value. The “Resolution” can be used to take into account the idle channel
noise of hearing aid and measurement equipment.

Note: The resolution value must be set high enough to take idle
channel noise into account. If it is set too low, especially
measurements with high gain at low input levels may be aborted due
to invalid result values.

Note: If the use of filters leads to slow measurements, the timeout
value may have to be increased.

With the “exponential” type of settling, differences between the earlier
results may be higher than specified, but the results must converge
exponentially into the specified values.

If the settling time of the hearing aid is known, measurement may be faster
with settling turned off. In this case the known settling time has to be
entered as pre-delay in the measurement parameters of each
measurement.
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Function settling is generally not applied to battery current measurements.
For harmonic distortion measurements the resolution is set fix to 0.01 %
THD.

“Standard” allows to select one of the available standards. Measurements
belonging to this standard will be checked in the measurement menu. If
“Allow only standard measurements” is checked, it is not possible to start
single measurements which do not belong to the standard.

If “Select standard at startup” is checked, the selection window for the
standard is opened at each start of the program.

“Ear simulator” allows to select the type of ear simulator used. For details
on the handling of calibration data see section 4 (“Calibration”) below.

If “Select ear simulator at startup” is checked, the selection window for
the ear simulator is opened at each start of the program.

“Ambient conditions” allows to change the temperature, relative humidity
and atmospheric pressure values for the protocol.

“Query ambient conditions at startup” causes the input window for the
ambient condition to be opened at each start of the program.

“Test method” allows to select the test method for transfer
measurements. With “Substitution”, the nominally set SPL at the input of
the hearing aid is assumed to be correct, due to the calibration of the sound
source. With “Comparison”, the input SPL is measured simultaneously with
the output SPL by the reference microphone in a two channel
measurement, and results are corrected for the deviation of the input SPL
from the nominal value. “Comparison” can not be selected when the
continuous current measurement is active or when the coupler microphone
is used as reference microphone (see below).

“Use coupler mic as reference mic” allows to use the microphone of the
IEC 126 coupler for sound source calibration. In this case the program
applies the calibration value of the coupler microphone for the sound source
calibration, and the reference microphone has to be connected to analyzer
input 1 instead of analyzer input 2.

If “Show operator instructions” is checked, instructions to the operator
are displayed in a message box before the measurement starts. The
operator may be prompted to position the hearing aid in a defined way or to
set the volume to a certain setting.

“Store results of further measurements” allows to include results
obtained with the “Add measurement” softkey to the result database. All
curves obtained this way will be reported in the same graph. This allows
e.g. to measure responses depending on settings of the hearing aid, and to
report them in a field of curves.

“Battery voltage” allows to specify the supply voltage for the hearing aid. If
a supply voltage is specified in the parameters of a measurement, the
general setting is overridden. This allows to measure response curves for
different supply voltages within one sequence.

“Report settings” allows to define the type of information which should
appear in the reports. For details on reporting, see section 8 below.
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4 Calibration

Calibration Devices

R&S UPV-K7 allows to simultaneously store calibration values for multiple
individuals of the same type. This allows to switch devices without the
requirement for re-calibration. However, regular re-calibration is
recommended in order to assure the correct function of the used devices.

@Hearing Aid Tests
File Data | Calibration Measurement  Sec

Selective
Microphone r
Ear Simulatar r

Sound Source

Induckion cail
Current Sense Resistor

Mewy Device

Select Device

Showe all walues

Fig. 11 Calibration menu

For every device to be calibrated, an entry must be created using
“Calibration > New device” in the main menu. This menu item opens an
entry window to specify the calibrated device. A category of device must be
chosen from the combo box on top. Type, manufacturer and serial number
are entered into the text boxes below. The entries are confirmed by clicking
on the “Save and close” button.

@Ealihrated Derice O]

Ilzage

| =]
Type

bl anufacturer

Serial Murnber

Cancel | | Save and C|IIISEI
b

Fig. 12 Input window for information about calibrated device
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Before a device can be calibrated or used, it must be selected with
“Calibration > Select device” in the main menu. Clicking on this item opens
a window with a table of all entered devices.

®Select Calibrated Devices M =]

| Manufacturer | Type | Serial Mo | Date and Time | Calib. value | File name
Diefault 1A10/2007 B:24 P D:\Hearing\Call

GR.AS 404G 1234 1/11/2007 11.00 & D:\Hearing\Call
Default 1/10/2007 £:24 PM [:MHearing\Call
Default 1/10/2007 6:24 PM D:MHearinghCalz
Detault 1/10/2007 B:24 PM D:MHearing\Cal=
Detault 1/10/2007 B:24 PM D:MHearing\Cald

ISeIect Usage Type j Selecth Cancel | ak I

Fig. 13 Window for selection of calibrated devices

In the combo box lower left, a category of devices must be selected.
Subsequently the table is reduced to available devices in this category. At
first startup, there is only a “Default” device for each category, but when
more devices have been created with the “New device” function, a choice
will be available in this view. In this state a row in the table can be marked
with @ mouse click on its left end. A mouse click on the button “Select”
selects this device for the associated usage.

®Select Calibrated Devices M =]

| Manufacturer | Type | Serial Mo | Date and Time | Calib. value | File name
G.R.AS. 404G 1234 111/2007 11:004M  [rull] D:4Hearing\Call
Default 1/10/2007 6:24 PM (ruall) D:4Hearing\Call

IEC 126 Covpler Miciophone 7] Select | Cancal | o |

Fig. 14 Selection window for particular device type (here IEC 126 coupler)

Subsequently this procedure may be repeated for other categories. Finally
all selections are confirmed by clicking the “Ok” button.

All calibration data are stored on the R&S UPV hard disk and are therefore
automatically available again after every restart. The calibration values for
the R&S UPV-K7 option are stored independently of other options.

All calibration routines below require as pre-requisite that a device for the
respective usage has been generated and selected.
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To simplify the procedure for the case that it is not intended to use multiple
devices of the same category nor to include information about the used
devices into a report, there is a “Default” device selected for each device
type or category after the first start of the program.

Microphone Calibration
» Insert the measuring microphone fully into the adapter of the sound
level calibrator and switch on the calibrator.

Note: After inserting the microphone, wait about 10 s to allow for
static pressure equalization.

» Call the test routine with “Calibration - Microphone = Coupler” or
“Calibration - Microphone - Reference” from the main menu,
depending on the microphone.

Conneck microphone ko Analvzer input 1,
Insert microphone inta calibrator and switch on calibrator,

Fig. 15 Initial window of microphone calibration

Next, the nominal SPL of the calibrator has to be entered:

Calibration SPL in dBspl
I 93.983:

Cancel | Ok I

A
Fig. 16 Input window for calibration SPL

If selective calibration is activated in the calibration menu, the frequency
of the calibration signal has to be entered:

Calibration Frequency [Hz]
I 1 IZIEIEI.EIEIE:

Cancel | Ok I

4

Fig. 17 Input window for calibration frequency

Subsequently, the output voltage of the microphone is measured and
the sensitivity displayed with reference to 1 Pa. If a mere power supply
without gain is used, the displayed sensitivity must approximately match
the value in the calibration certificate of the microphone capsule (typical
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value for microphone capsule 4134 of artificial ear 4185 is approx.
12 mV/Pa, display = 120 mV/Pa). If a conditioning amplifier with 20 dB
gain (recommended value) is used, the displayed sensitivity must be
about 10 times higher. If the voltage measured is below 3 mV or
instable, an error message is displayed. Possible error sources are, for
example, a switched-off microphone power supply or a disabled
calibrator. In this case, the program requests that the calibration is
repeated. After switching on the microphone power supply, wait approx.
20 s before starting the calibration again.

Calibration of Ear Simulator IEC 711

For calibration of the IEC 711 ear simulator, an adaptor part must be
screwed onto the simulator which allows it to be inserted into the calibrator
like a 2" microphone. The calibration routine is started with “Calibration >
Ear Simulator - IEC 711” and follows the course described above.

Calibration of Sound Source

Before a hearing aid can be tested, the absolute sensitivity and frequency
response of the sound source have to be measured and corrected with the
aid of a previously calibrated reference microphone. If “Use coupler mic as
reference mic” is activated in the “Options” menu, the microphone of the
IEC 126 coupler can be used for this purpose. The frequency response of
the microphone can be ignored in the test frequency range (100 Hz to
10 kHz) (see also calibration certificate of microphone capsule). If a
separate reference microphone is used, this has to be calibrated
beforehand with “Calibration > Microphone - Reference”.

After starting the sound source calibration with “Calibration = Sound
Source”, the calibration level can be defined. This allows to adapt the
calibration to specific measurement levels. It is also possible to store
calibrations for different levels using multiple calibration devices (see
above).

The sound pressure generated at the point of the reference microphone is set to
exactly the specified level in an automatic measurement routine at 1 kHz. The
generator voltage required is stored in a file on the hard disk and used as a
reference for all subsequent settings with the same sound source. If the sound
pressure cannot be adjusted to the specified value, an error message is
displayed with a request to check the connection to the sound source and to
repeat the measurement.

The uncorrected frequency response of the sound source is measured and
displayed. Next, the frequency response is measured with the inverse
frequency response correction automatically selected in the generator
(equalization). Residual errors caused by nonlinearities of the speaker are
measured and taken into account in the final equalization file as fine
correction.

To verify the results, the absolute sound pressure versus frequency is
measured at the specified sound pressure level. Correct calibration without
interfering sound yields an almost straight line.
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5 Data Entry for Reporting

Operator

Under “Data->Operator” an operator’'s name can be entered which is stored
in association with all calibration and measurement results. If “Operator” is
activated in the report settings, the name will appear in all reports about
these measurements.

Test object

Under “Data > Test object > New” a description of the device under test
can be entered.

¢ Test Object =]
Mame

fl

Type

b anufacturer

Senal Murmber

[T AGC

Cancel Save and cloze
| | ],

Fig. 18 Window for input of information about a test object

With “Data - Test object > Select” one of the entered test objects can be
selected. The data of this selected test object will be stored in association
with all measurements and appear on the associated reports if “DUT
information” is activated in the report settings.
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Functionality and control of the measurement macros

@)Frequenty Response {Generic) = [Ofx]

58,887

50

40

a0

Gain [dB]

20

I 1 1 1 1 [ 1 I 1 1 I 1 1
300 400 500 600 800 1000 2000 3000 4000 50006000 8OO0 10000

E - Frequency [Hz]

B codesPL Hra- 414506 [ Limit Gain

Mo Standard  |IEC 126 [Substittion  |ather | 15V [wide Band T

Display Level | Calculate HFA,

Fig. 19 Example of a measurement window

Sa‘ﬁﬂ%#‘ﬁ: As Create Report Closs

Mea:l.l‘?ement Save Curve s | Load Curve

When a measurement macro is started, e.g. from the “Measurement’
menu, the standardized measurement is immediately executed. With a
single measurement, the window of the measurement macro stays open
after the measurement is terminated. At that time, the following functionality
is available:

Lo ot
N[y Eael ]
Shows Cursar

Change Scale
Data Point Size
Cornrnent

Fig. 20 Context menu of the graph window

Zooming

When the “Shift” key on the keyboard is pressed, the mouse cursor
changes to the zoom cursor. When the left mouse button is pressed, a
rectangle can be marked in the graph. As soon as the left mouse button is
released, the graph is zoomed into the area of the marked rectangle

“Zoom Out” in the graph context menu reverses the last zooming step.
“Unzoom” zooms completely out to the original scaling.
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Changing the Scale of the Graph

“Change Scale” in the context menu opens a window in which the upper
and lower bounds of both axes can be entered by numbers.

@Ehange Scale =]

# MirirnLam # M aximLim
| 100. EIIII::I | 1 IIIEIEIIZI.EIEI::I
" MirirnLam "t amirnm

| S000=] | 0.00=]
Caricel ok |
dnce | /

o

Fig. 21 Window for changing the scale of the graph

Cursor

When the item “Show Cursor” is marked in the graph context menu, a
cursor is displayed which can be dragged along the graph with the mouse.
X and Y values of the data points below the cursor are displayed.

Fig. 22 Cursor with data display

Data Point Size

“Data Point Size” in the graph context menu opens a window in which the
size of marks at the measured data points can be specified. Moving the
mouse cursor over one of the marks causes the associated X and Y values
to be displayed.

k
(1000.00, 48.05)

]

Fig. 23 Data points with data display

Making Additional Measurements

The softkey “Add Measurement” triggers another measurement according
to the specification of the test. Loudness ratings and noise values are
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calculated and displayed in the legend. However, limits are not checked.
This function can e.g. be used to compare different settings in a device
under test.

If the item “Store results of further measurements” is activated in the
“Options” menu, graphs and result values obtained with this functionality are
added to the results database and will appear later in reports on this
measurement. All curves obtained within the same measurement will
appear in the report in the same graph.

Storing and Loading Curves

All measured curves in the graph can be stored to an ASCII file, and stored
curves can be loaded back into the graph. The softkey “Store Curve” opens
a window in which a combo box offers choice between the legends of all
measured curves in the graph. The curve associated in which the selected
entry is stored to the file at the specified location.

Storing Curves as Limit Curves

With “Store As Limit Curve” a curve can be selected and stored into a
R&S UPV format limit file with a specified shift in Y axis direction. This
functionality can be used to generate limit curves from “golden” devices for
evaluation purpose. Regarding the use of such limit curves see section
“Customizing Measurements” below.

Entering a Comment

With the softkey “Enter Comment” or the item “Comment” in the graph
context menu, a comment can be entered and edited which will appear in
the report about the respective measurement.

Creating a Report

The softkey “Create Report” causes a report to be prepared. The report
preview window (see below) opens and shows the preview of the report.
Buttons in the preview window allow to print the report or to export it to PDF,
WORD, EXCEL or Rich Text format. For details see section “Preview
Window” below.

Closing the Measurement Window

The softkey “Close” closes the measurement window. The control is
returned to the R&S UPV-K7 main window. All relevant data associated with
the measurement is imported to the results database. A new entry appears
for the measurement as new row on the bottom of the overview data grid in
the main window.
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Customizing Measurements

The first item in the “Measurement” menu which is called “Settings” opens a
sub-menu with all available measurements in it. Clicking on a measurement
in this sub-menu opens a window which allows to change parameters of the

selected measurement.

@)Parameters of Frequency Response {Generic)

Giain or output level over frequency with input

level az parameter.

IW A4/2007 10:03:51 AM

DOperator instruction

Template Files
Hal File Mame

Add

Parameters

- [Ofx]

Upper margin [dB] Lower margin [dB

Number I Uaﬁ Delete | Edit |

Connect output of hearing aid to measurement | & N°| Name | Tupe | Default Valud Fisn 2
coupler. Set gain control to pre-defined position 1 battery voltage [v) Double 1.5 Fals
and switch on hear!ng aid. Place hearing aid in 2/ lower frequency limit [Hz) Double 200 Fals

reference test position. —

3| upper frequency limit [Hz] Double 5000 Fals
ﬂ 4| number of frequencies Integer 57 Fal:
= i 5/ dizplay result as gain Boolean true Fal:
6 selective measurement Boolean False Fal:
FR1 7| number of sweeps Parameter 1 Fal:
8| sweep 1 level (dB) Double B0 Fal:
Nul FEms 9 measurement delay [s] Double 0.02 Fal:
1 FRT set 10/inductive ! EBoolean false Fal:

11 number of HFA, frequencies Parameter 3 Till

4« | B

Number Iﬂ Edit |

MNumber Iﬂ Edit | Cancel |

Fig. 24 Measurement setup window

The “Title” appears in the measurement menu and forms the heading of the
report.

The “Description” can be chosen to be included into the report.
“Date” shows the date of the last change to this measurement definition.

“Operator instruction” is the text displayed before the start of each
measurement, provided that the item “Show operator instructions” is
activated in the “Options” menu.

The entry in the field “Program File” designates the measurement type and
must not be changed.

The field “Setup Files” specifies the R&S UPV setups used by the
measurement. The specified file can be replaced by a user defined file but
the number of setups is defined by the measurement type. The customized
setup file must be stored in folder D:\Hearing. It is recommended to
generate customized setups by copying existing ones. Note that changes in
the setup like changing the analysis function or generator signal may cause
malfunction of the measurement. Some parameters of the setup might be
overwritten by the macro during the measurement run.

The field “Template files” specifies limit template curves for the response
curve. The buttons “Add” or “Edit” produce the following input window:
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Template Curve
Mumber I1

| Upper limit |

Lowaer limit |

File: name Browss |

Cahicel | Ok

4

Fig. 25 Input window for limit template curve

The radio buttons allow to determine whether the given curve should be
used as upper limit, lower limit or for information only (no limit check). The
field “File name” must contain the path name of the file. To generate a new
limit curve file, use the softkey “Save as limit curve” of the respective
measurement window or copy and edit an existing limit file using a text
editor.

All other available parameters of a measurement definition are shown in the
“Parameters” data grid. The rightmost column with the headline “Fixed”
displays whether the respective parameter can be changed by the operator
or not. In “generic’ measurements all parameters may be changed. In
measurements which follow standards, only parameters which are not
determined by the standard may be changed by the operator. The “Edit”
button opens an input window for the parameter in the line specified in
“Number”:

Mumber I 1

Mame

battery voltage [V]

Type

IDDubIe j

Walue
5

= Locled

Cancel | Ok I
4

%

Fig. 26 Input window for parameter value

“Name” appears in the report and explains the meaning of the parameter.
“Type” is determined by the measurement routine and cannot be changed.
In the field “Value” a value must be entered which conforms with the syntax
rules of the selected data type. The syntax is checked automatically when
the text box is left. However there is no check for the allowable range of the
value. Entering inadequate values (e.g. too high levels, negative
frequencies) may cause malfunction of the measurement.

24 E-1



Acoustic Measurements on Hearing Aids

Notes on Individual Measurements

Frequency Response Measurement

@Frequency Response {(Generic) M (=]

53.887

50

40

an

Gain [dB]

20

] ] I ] ] [ [l ] [ [l [
500 B00 800 1000 2000 3000 4000 50006000 8000 10000
Frequency [Hz]

41.45dB

Mo Standard |IEC 126 [substintion  |ather | 15V [wide Band T

Display Level | Calculate HFA,

Fig. 27 Display window of frequency response measurement

Save Curve bs
Limit File | Create Report

Save Curve A | Load Curve

Add
Measuremnent Close

The softkey “Display Level” or “Display Gain”, respectively, allows to toggle
between gain and level in the Y axis of the graph. The button “Calculate
HFA” allows to calculate a high frequency average or special frequency
average from one of the displayed curves:

HFA frequencies [Hz]  Calculate HEA fiar
000 Curee with inpt level

1600 =
Senp len.00 e =l

Calculate

43.49 4B

Cloze

[l

Fig. 28 Input window for HFA calculation
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In the text box on the left side the HFA frequencies are entered in separate
lines. In the combo box top right, one of the existing curves is chosen.
When the button “Calculate” is clicked, the text box below shows the
associated HFA value.

The following table lists all available parameters in the generic frequency
response measurement.

Name Type Value Explanation

battery voltage (V) Double 0 Supply voltage provided at
ANLG AUX OUT. Overrides the
general setting. "0 V" means
“use voltage from general

setting”.
lower frequency limit (Hz) Double 200 Start frequency of sweep
upper frequency limit (Hz) Double 5000 Stop frequency of sweep
number of frequencies Integer 57 Number of sweep points
display result as gain Boolean True »True®: Gain on Y axis, ,False™:
SPL on Y axis
selective measurement Boolean false ,True": Selective measurement
with fast 3rd octave filter
number of sweeps Parameter count 1 Number of sweeps with level as
parameter
sweep 1 level (dB) Double 60 Sweep level for each sweep
(dBSPL or dB re 1 mA/m)
measurement delay (s) Double 0.02 Pre-delay between sweep Step

and measurement trigger,
allows for settling of the DUT

(e.g. AGC)

inductive Boolean false “False”: Acoustic input, “True":
Inductive input

number of HFA frequencies Parameter count 3 Number of frequencies
averaged in the high frequency
average

HFA frequency 1 (Hz) Double 1000

HFA frequency (Hz) Double 1600

HFA frequency (Hz) Double 2500

HFA upper limit (dB) Double 30 Upper limit for limit check

HFA lower limit (dB) Double 10 Lower limit for limit check

check limit for sweep no. Byte 1 “0" means: “don't check”

calc. freq. range for swp. no  Byte 1 “0" means: “don't calculate”

level difference (dB) Double 20 Level difference between HFA
level and frequency response
limit points

check frequency range limits ~ Boolean True Determines whether the
frequency range is checked
against the limits given below

max. lower frequency (Hz) Double 500

min. upper frequency (Hz) Double 3500

display curve maximum Boolean True Stipulates whether the absolute
curve maximum should be
determined

lower limit of max. (dB) Double 0

upper limit of max. (dB) Double 40

check max limits for swp. no  Byte 1 "0" means: “don't check”

Table 1 Available parameters for frequency response measurements
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If for example only an upper limit should be checked but not the
corresponding lower one, select the lower limit low enough to be always
passed.

The following standard conformal tests are based on the frequency
response measurement routine:

Frequency Response @ 60 dBSPL (IEC-0)
Frequency Response (ANSI)

Field of Frequency Response Curves (IEC-0)
Frequency Response (IEC-7)

Frequency Response Induction (ANSI)
Frequency Response Induction (IEC-1)
Full-On Gain 50 dB (IEC-0)

Full-On Gain 60 dB (IEC-0)

Full-On Gain (IEC-7)

Response Curve at Maximum Gain (IEC-1)
Full-On Gain (ANSI)

Output SPL at Maximum Gain, Induction (IEC-1)
OSPL90 (ANSI)

OSPL90 (IEC-7)

OSPL 90 (IEC-0)

Saturation Sound Pressure Level Measurement

®Saturation SPL (Generic) M =]

130,76

120

110

100

SPL [dB]

90

an

70

59238

] I ] ] ] ] ] [ [ [ [ [ ] ] ]
100 200 300 400 500 E00 200 1000 2000 3000 4000 50006000 200010000
Frequency [Hz]

B 1 hiax 12153 dBSFL

Mo Standard |IEC 126 [substintion  |ather | 15V [wide Band T

| Meagﬁgmant Save Curve s | Load Curve

Fig. 29 Display window of saturation sound pressure level measurement

Save Curve bs

Limit File (e

| Create Report

The saturation sound pressure level measurement performs the specified
number of level sweeps and records the maximum level obtained in each
sweep.
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The following table lists all available parameters in the generic saturation
sound pressure level measurement.

Name Type Value Explanation

battery voltage (V) Double 1.5 Supply voltage provided at
ANLG AUX OUT. Overrides the
general setting. "0 V" means
“use voltage from general

setting”.
lower frequency limit (Hz) Double 200 Start frequency of sweep
upper frequency limit (Hz) Double 8000 Stop frequency of sweep
number of frequencies Integer 65 Number of sweep points
lowest input level (dB) Double 60 Start level of sweep (dBSPL or
dB re 1 mA/m)
highest input level (dB) Double 90 Stop level of sweep (dBSPL or
dB re 1 mA/m)
number of levels Integer 31 Number of level steps in sweep
selective measurement Boolean false ,True": Selective measurement
with fast 3rd octave filter
measurement delay (s) Double 0.02 Pre-delay between sweep Step

and measurement trigger,
allows for settling of the DUT

(e.g. AGC)

inductive Boolean false “False”: Acoustic input, “True":
Inductive input

display curve maximum Boolean True Stipulates whether the absolute
curve maximum should be
determined

lower limit of max. (dB) Double 130

upper limit of max. (dB) Double 150

check max limits Boolean true Stipulates whether pass / fail

check takes place
Table 2 Available parameters for saturation SPL measurements

The only standard conformal test based on the saturation SPL
measurement routine is Saturation SPL (IEC-0).
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Harmonic Distortion Measurement

@)Harmnnit Distortion {Generic) = [Ofx]

I i
100 1000 10000
Frequency [Hz]

B ho ok I ondeo e M adcode B THo 06 BN ondso e M dsode I THD 10006 B 2ndioode I ad100 8

Mo Standard  |IEC 126 [Substittion  |ather [ 15y T
Display dB | Shn\\}ualfl)‘::greta Add

Measurement
Fig. 30 Curve display of harmonic distortion measurement

Save Curve s

Limit File | Create Report Close

Save Curve s | Load Curve

The softkey “Display dB” or “Display %”, respectively, allows to toggle
between both Y axis units. The softkey “Show Discrete Values” or “Show
Curves”, respectively, allows to toggle between curve display and result
data table provided that discrete values or curves, respectively, have been
measured.

@Harmunic Distortion {Generic) 9 [=]
Result Data
Frequency | Lewel | THD | THL fimit | THD werdict | 2nd | 3d | dth | Gth | Bth |
5.343432468 1 Fail 5.26617 % 0896504 % 0211765 % |0143414% 0153519 %
0.340588567 0.5 Pass 011137 % 03171144 % (00728366 % 00282086 % 0.024344 2
0.838577806 0.5 Fail 0818163% 018274 % 00114115 % 000845126 | 0.00748032

NoStandard  [IEC125 [substintion  |ather [ 1sy] T

Display dB | Show Graph Meail?gmant

Sa\ﬁmci#\ﬂg A Create Report Close

Save Curve A | Load Curve

Fig. 31 Data table display of harmonic distortion measurement
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The following table lists all available parameters in the generic frequency
response measurement:

Name Type Value Explanation
battery voltage [V] Double 0 Supply voltage provided
at ANLG AUX OUT.

Overrides the general
setting. "0 V" means
“use voltage from
general setting”.

lower frequency limit [Hz] Double 200 Start frequency of sweep
upper frequency limit [Hz] Double 5000 Stop frequency of sweep
number of frequencies Integer 57 Number of sweep points
display result in dB Boolean false “False”: Y axis and

values in %, “True”: Y
axis and values in dB

number of sweeps Parameter count 3 Number of sweeps with
level as parameter

sweep 1 level [dB] Double 60 (dBSPLordBre 1
mA/m)

sweep 2 level [dB] Double 80 (dBSPLordBre 1
mA/m)

sweep 3 level [dB] Double 100 (dBSPLordBre 1
mA/m)

measurement delay [s] Double 0.01 Pre-delay between

sweep Step and
measurement trigger,
allows for settling of the
DUT (e.g. AGC)

induction Boolean false “False”: Acoustic input,
“True”: Inductive input

show thd Boolean true Stipulates whether the
thd curve is displayed

show 2nd Boolean true Stipulates whether curve
of 2" harmonic is
displayed

show 3rd Boolean true Stipulates whether curve
of 3™ harmonic is
displayed

show 4th Boolean false Etc.

show 5th Boolean false

show 6th Boolean false

show 7th Boolean false

show 8th Boolean false

show 9th Boolean false

check limit for sweep no. Byte 0 Stipulates whether limit

curve is checked. “0”
means no limit check

number of discrete points Parameter count 3 Number of discrete
measured values

point 1 [Hz], [dB], limit String 500, 70, 1 Value triples specifying
measurements and
upper limits

point 2 [Hz], [dB], limit String 800, 70, 0.5

point 3 [Hz], [dB], limit String 1600, 65, 0.5

check limits Boolean true Stipulates whether limits
are checked in discrete
measurements

Table 3 Available parameters for harmonic distortion measurements
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The following standard conformal tests are based on the harmonic
distortion measurement routine:

Harmonic Distortion (ANSI)
Harmonic Distortion (IEC-7)
Harmonic Distortion (IEC-0)

Measurement of Dynamic Behaviour (AGC Settling)

@)Dynamic Behaviour {Generic) = [Ofx]

125

120

115

110

1 1
0.4 05 . . . X 0.33
Time [s]

E High level setting time = 16.513 ms Low level settling time = 126.000 ms

Mo Standard  |IEC 126 [Substittion  |ather | 15V [wide Band T

| Meail‘?:mﬁnt Gawe Curve ts | Laad Curve

Fig. 32 Measurement window for dynamic behaviour

Save Curve As
Limit File | Create Report

Clage

The following table lists all available parameters in the generic dynamic
behaviour measurement:

Name Type Value Explanation

battery voltage (V) Double 0 Supply voltage provided at
ANLG AUX OUT. Overrides the
general setting. 0 V" means
“use voltage from general

setting”.

test frequency (Hz) Double 2000 Frequency of sine burst tone

high level (dB) Double 80 High level of sine burst (dBSPL
or dB re 1 mA/m)

low level (dB) Double 55 Low level of sine burst (dBSPL
or dB re 1 mA/m)

on time (s) Double 0.25 Duration of high level

interval (s) Double 1 Period duration of sine burst

selective measurement Boolean False “True”: Signal filtered with one
octave width around test tone
frequency

induction Boolean false “False”: Acoustic input, “True":
Inductive input

store diagram Boolean true “False”: Only values are stored

in the database (saves disk
space), “True” compressed
curve is stored in the database
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Name Type Value Explanation

display dB Boolean true “False”: Sound pressure on Y
axis, “True”: SPL on Y axis

attack tolerance (dB) Double 2 Settling time is determined as

the time after which the curve
approaches the steady value
closer than this difference

attack time lower limit (ms) Double 20 Lower limit of high settling
time for limit check

attack time upper limit (ms)  Double 150 Upper limit of high settling
time for limit check

release tolerance (dB) Double 2 Settling time is determined as

the time after which the curve
approaches the steady value
closer than this difference

release time lower limit (ms)  Double 50 Lower limit of low settling time
for limit check

release time upper limit (ms)  Double 300 Upper limit of low settling time
for limit check

check limits Boolean true Stipulates whether limits of

settling times are checked
Table 4 Available parameters for dynamic behaviour measurements

The following standard conformal tests are based on the dynamic behaviour
measurement routine:

Dynamic Behaviour (ANSI)

Dynamic Behaviour at High Level (IEC-2)
Dynamic Behaviour at Speech Level (IEC-2)
Dynamic Behaviour (IEC-7)

Measurement of Input-Output Characteristics

@)Input - Dutput Characteristics {(Generic) = [Ofx]

130

120

SPL [dB]

I i 1 ] 1 ] ] i
40 50 60 7l 20 100 10 120 12724
Input Level [dB]

E 500 Hz AGC Threshold = 84.46 dBSPL, Compression Ratio = 1.74 E 2000 Hz AGLC Threshold = £9.34 dBSPL, Compression Ratio = 5.49
E 1000 Hz AGC Threshold = 75.80 dBSPL, Compression Fatio = 4.43

Mo Standard  |IEC 126 [Substittion  |ather | 15V [wide Band T
Display Gain | EE;';“E:‘D

Fig. 33 Measurement window for input-output characteristics

Sa‘ﬁﬂ%#‘ﬁ: As Create Report Closs

MEB:U?:mEnt Save Curve s | Load Curve
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The softkey “Display Gain” or “Display Level’, respectively, toggles the Y
axis data between gain and sound pressure level. With the softkey
“Calculate Comp. Ratio” a compression ratio may be calculated for any of
the measured curves.

Compression Ratio

Calculate
Lawer Level carmpresziaon ratio for
curve with frequency

| B0.00=H 2000 Hz =l

pper Lewvel
| 85.00= | 5 61

Cloze |

Fig. 34 Window for calculation of compression ratio

With “Lower Level” and “Upper Level” the input levels for the compression
ratio calculation are determined. The combo box top right selects one of the
measured curves. When the button “Calculate” is clicked, the compression
ratio is calculated and displayed in the text box below.

The following table lists all available parameters in the generic input-output
measurement:

Name Type Value Explanation

battery voltage (V) Double 0 Supply voltage provided at
ANLG AUX OUT. Overrides the
general setting. "0 V" means
“use voltage from general

setting”.

lowest input level (dB) Double 40 Start level of sweep (dBSPL or
dB re 1 mA/m)

highest input level (dB) Double 90 Stop level of sweep (dBSPL or
dB re 1 mA/m)

number of level steps Integer 50 Number of level steps in sweep

display result as gain Boolean false “False”: Level on the Y axis,
“True”: Gain on the Y axis

selective measurement Boolean False “True”: selective measurement
with fast 3™ octave filter

number of sweeps Parameter count 3 Number of sweeps with
frequency as parameter

sweep 1 frequency (Hz) Double 500

sweep 2 frequency (Hz) Double 1000

sweep 3 frequency (Hz) Double 2000

measurement delay (s) Double 0.05 Pre-delay between sweep Step
and measurement trigger,
allows for settling of the DUT
(e.g. AGC)

induction Boolean false “False”: Acoustic input, “True":
Inductive input

calculate values Boolean true “True": AGC threshold and
compression ratio are
determined for each curve

AGC threshold upper limit Double 80 Upper limit for limit check of

(dB) AGC threshold
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Name Type Value Explanation

AGC threshold lower limit Double 60 Lower limit for limit check of

(dB) AGC threshold

compression input level 1 Double 80 Lower input level for

(dB) compression ratio calculation
(dBSPL or dB re 1 mA/m)

compression input levl 2 (dB) Double 85 Higher input level for

compression ratio calculation
(dBSPL or dB re 1 mA/m)

compression ratio upper limit  Double 8 Upper limit for limit check of
compression ratio

compression ratio lower limit ~ Double 4 Lower limit for limit check of
compression ratio

check limit for curve no. Byte 2 "0"” means “don't check”

Table 5 Available parameters for input-output measurements

The following standard conformal tests are based on the measurement
routine for input-output characteristics:

Input-Output characteristics (ANSI)
Input-Output characteristics (IEC-2)
Input-Output characteristics (IEC-7)

Measurement of Equivalent Input Noise

@Equivalent Input Noise 1,3 oct. {(Generic)

50

SPL, Gain [dBSFL. dB]

[ ] [}
1000 10000 14745
Frequency [Hz] d Pass

m Equivalent input noise m Gain m 3 Inp. noise closed. Diff. =-1.36 dB m Input noise off. Diff, = 16.70 dB

Mo Standard |IEC 126 [substintion  |ather [ 1sy] T

| Meagﬁgmant Save Curve s | Load Curve

Fig. 35 Measurement window for equivalent input noise

Save Curve bs
Limit File Create Report

Close
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The following table lists all available parameters in the generic
measurement of equivalent input noise:

Name Type Value Explanation

battery voltage (V) Double 0 Supply voltage provided at
ANLG AUX OUT. Overrides the
general setting. 0 V" means
“use voltage from general

setting”.

lower cutoff freq. (Hz) Double 175 Lower band limit for wideband
noise measurement

upper cutoff frequency (Hz) Double 5650 Upper band limit for wideband
noise measurement

gain test input level (dB) Double 60 Level for measurement of gain
(dBSPL or dB re 1 mA/m)

integration time (s) Double 1 Integration time for noise
measurement

predelay (s) Double 0 Pre-delay between sweep Step

and measurement trigger,
allows for settling of the DUT

(e.g. AGC)

induction Boolean False “False”: Acoustic input, “True":
Inductive input

number of HFA frequencies Parameter count 1 Number of frequencies
averaged for gain measurement

HFA frequency 1 (Hz) Double 1600

check closed input Boolean True “True”: Repeat noise

measurement with sealed input
and check level difference

max level difference (dB) Double 1 Maximum acceptable noise
level difference between input
open and input sealed

check off Boolean True “True”: Repeat noise
measurement with hearing aid
switched off

min. level difference (dB) Double 10 Minimum acceptable noise

difference between hearing aid
switched of and hearing aid
switched on with input open

maximum noise level (dBSPL) Double 40 Maximum noise level for
pass/fail check

check limits Boolean True Stipulates whether limit should
be checked

display spectrum Boolean True “True”: Noise spectrum is

measured with a sweep of a
fast 3" octave filter

lower frequency (Hz) Double 200 Lowest 3" octave center
frequency

upper frequency (Hz) Double 5000 Highest 3" octave center
frequency

number of frequencies Double 15 Number of 3™ octaves

measured, must match the
number of 3™ octaves including
the lowest and highest one

Table 6 Available parameters for equivalent input noise measurements

The following standard conformal tests are based on the measurement
routine for equivalent input noise:

Equivalent Input Noise (ANSI)
Equivalent Input Noise 1/3 oct. (IEC-0)
Equivalent Input Noise (IEC-7)
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Battery Current Measurement

@)Battery Current (Generic) 9 [=] 3

]

25

Batt. Current [mé]

05
1] [} ] ] [} ] [}
n 50 &0 70 a0 a0
Input Level [dB]
B so0H- B 1000 Ho [ 2000 Ha
Mo Standard  IEC 711 (Compaison | Sample Heang &id1 | 1.3V T

Save Curve As

i (5 Create Report Cloze

Show Discrete Add
alues Measurement

Fig. 36 Graphic display of battery current measurement

Save Curve A | Load Curve

@)Battery Current {Generic)
Result Data
Frequency (H | Lewel [dB] | Current [md) | Lower limit [ | Upper limit [m |Verdict
1.085509033 1 0.05 25 Pass
1.324192271 1 0.05 5 Pass
28015623531 0.05 i Pass

NoStandard  [IEC 125 [Substittion  |ather [ 15y T

| Add
| Sl Erzstn teasurement

Save Curve As
Limit File | Create Report

Save Curve s | Load Curve Clage

Fig. 37 Value table display of battery current measurement

The softkey “Show Discrete Values” or “Show Graph”, respectively, toggles
between the graph view and the data table view of the measurement
window.
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The following table lists all available parameters in the generic battery

current measurement:
Name

battery voltage (V)

lowest input level (dB)
highest input level (dB)

number of level steps
number of sweeps

sweep 1 frequency (Hz)
sweep 2 frequency (Hz)
sweep 3 frequency (Hz)
measurement delay (s)

induction

check limits for curve no
number of discrete points

point 1 (Hz), (dB), lower limit,
upper limit

point 2 (Hz), (dB), lower limit,
upper limit

point 3 (Hz), (dB), lower limit,
upper limit

check limits

Type
Double

Double
Double

Integer
Parameter count

Double
Double
Double
Double

Boolean

Byte
Parameter count

String

String

String

Boolean

Value

0

40
90

50

500

1000
2000
0.05

false

1000,
0, 0.05,

1000,
60,
0.05, 5
1000,
90,
0.05, 8
true

Explanation

Supply voltage provided at
ANLG AUX OUT. Overrides the
general setting. 0 V" means
“use voltage from general
setting”.

Start level of sweep (dBSPL or
dB re 1 mA/m)

Stop level of sweep (dBSPL or
dB re 1 mA/m)

Number of level steps in sweep

Number of sweeps with
frequency as parameter

Pre-delay between generator
setting and measurement
trigger, allows for settling of the
DUT (e.g. AGC)

“False”: Acoustic input, “True":
Inductive input

"0"” means “don't check”

Number of discrete measured
values

Value triples specifying
measurements and upper limits

Stipulates whether limits are
checked in discrete
measurements

Table 7 Available parameters for battery current measurements

The following standard conformal tests are based on the battery current

measurement routine:

Battery Current (ANSI)
Battery Current (IEC-0)
Battery Current (IEC-7)
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Routine for Reference Test Gain Setting

@)Reﬁarente Test Setting {Generic) _[O] %]
20 - - - -
Adjust volume setting of the hearing aid such that
the bar to the left is close to "0". If the bar is green,
159 the gain is within the specified tolerance.
10
5 -
04 OSPL HFA Current HFA
1 11361 dB 48.76 dB
_5 .
-104
Comment
154
_20 .
@
Mo Standard  |IEC 126 |Substitution other | 15V [wide Band T
| | STOP | [Sreate Feport [Close:

Fig. 38 Initial display of the routine for reference test gain setting

At start of the macro, the full-on gain or output SPL is measured and
averaged at the specified HFA frequencies. From this value a target level is
calculated.

The gain of the hearing aid at the specified frequencies is repeatedly
measured until the “STOP” button is clicked. The thermometer shows the
deviation from the target value. If the deviation becomes smaller than 3 dB,
the scale is enlarged. The colour of the thermometer is red as long as the
deviation is higher than the allowed tolerance and turns green as soon as
the deviation is within tolerance.
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@)Reﬁarente Test Setting {Generic) _[O] %]
5N - - - -
| Adjust volume setting of the hearing aid such that
4 the bar to the left is close to "0". If the bar is green,
i the gain is within the specified tolerance.
3_
2_
] -
04 OSPL HFA Current HFA
1 1 11361 dB 37.07dB
_2_
34 Comment
-4
_5_
@)
Mo Standard  |IEC 126 |Substitution lother | 15V [wide Band T

| |

Fig. 39 Display of the routine for reference test gain setting, adjusted

STOP | [Sreate Feport [Close:

A comment to be printed with the report (e.g. setting of the gain control)
may be entered in the “Comment” field.

The following table lists all available parameters for reference test gain
setting:

Name Type Value Explanation

battery voltage (V) Double 0 Supply voltage provided at
ANLG AUX OUT. Overrides the
general setting. 0 V" means
“use voltage from general
setting”.

selective measurement Boolean false “True”: selective measurement
with fast 3™ octave filter

OSPL as gain Boolean false Stipulates whether the full-on
value is measured as gain or as
level

OSPL (dB) Double 90 Input level for the full-on
measurement

RTS as gain Boolean true Stipulates whether the value
during adjustment is measured
as gain or as level

RTS level (dB) Double 60 Input level during adjustment
(dBSPL or dB re 1 mA/m)
measurement delay (s) Double 0 Pre-delay between generator

setting and measurement
trigger, allows for settling of the
DUT (e.g. AGC)

induction Boolean false “False”: Acoustic RTS input,
“True”: Inductive RTS input,
OSPL measurement is always

acoustic

number of HFA frequencies Parameter count 3 Number of frequencies
averaged for gain measurement

HFA frequency 1 (Hz) Double 1000

HFA frequency 2 (Hz) Double 1600

HFA frequency 3 (Hz) Double 2500

level difference (dB) Double -77 Difference between target value
and full-on value
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Name Type Value Explanation

upper tolerance (dB) Double 1.5 Maximum allowed difference
between value during
adjustment and target value

lower tolerance (dB) Double -1.5 Minimum allowed between
value during adjustment and
target value

Table 8 Available parameters for the reference test gain setting

The following standard conformal tests are based on the reference test gain
setting routine:

Reference Test Setting (ANSI)
Reference Test Setting (IEC-0)
Reference Test Setting (IEC-7)
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7 Automatic Test Sequences
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@Hearing Aid Tests

File Data Calibration Measurement | Sequence  Repor
Mew
OpEn ..

Test Results O venew

Fig. 40 Sequence menu

Creating and Editing a Sequence

The menu item “Sequence > New” first produces a window where a name
for the new sequence has to be entered. Subsequently the sequence
window opens.

@)Hearing Aid Tests =] E3

File Data Calbration Measurement Sequence Report Options Help

®5equence sample

Erattery Current [4MS1) = [l Full-On Gain IEC-7)

Eattery Current IEC-7) Append - vl OSPL90 (IEC-7)

Battery Current EE Eneric) Edit and & d M ira lIEL )

i -

Harmonic Distortion [Generic] &I bel Frequency Respanse IEC-7)

Harmoric Distortion Induction

Diwniamic Behaviour (AN S

[Diyriamic iour [Generic] Delete X

Dwnarnic Behaviour at High Level IEC-2)

Dynarnic Behaviour at Speech Level [[EC-2] Mave up

Frequency Fesponse [Generic]

Field of Frequency Response Curves(IEC-D)

Frequency Response IEC-7) —I

Frequency Response Induction [ANS1) Edilaaelcy

Frequency Fesponze Induction (IEC-1] =

Full-On Gain 50 dB (IEC-0) Run highlight=d

Full-On Gain (IEC-7]

Response Curve at Masimumn Gain IEC-1) Clear

Full-On Gain [&N5I]
Haimonic Distortion [ANS1]
Haimonic Distortion [JEC-7] Check all

Battery Current [IEC-0)
1
Frequency Response @ 60 dBSPL IEC-0)
Frequency Response [AMS]] Move down
Full-On Gain B0 dB IEC-O)
Harmonic Distartion |EC-0]

Input - Output Characteristics [BNS1)

Input - Output Characteristics [Generic) Ui ol

Input - Output Characteristics [|EC-2] o
Equivalent Input Moise 1/3 oct. (Generic)

E quivalent Input Moize [AM51] Save sequence az
Equirvalent Input Moige 1/3 act. (IEC-0]
Equirvalent Input Naige (IEC-7]

Output SPL at Masimurn G ain, Induction (IEC-1]
0SPLI0 [4NS1 hd| Close

[MoStandad  IECT28 Substiuion |ather | 1500
Ta first Stop/Cant FHepeat|ast Report
TR Start sequence sequence ezt Step | ISR Sequance Save sequence Save and close

Fig. 41 Sequence window

Initially the right checked list box is empty. The list box on the left side
displays all available measurement definitions. A measurement is
appended to the sequence by highlighting it in the list box on the left side
and clicking the “Append” button. Subsequently a measurement, which is
highlighted in the checked list box on the right side, can be moved within
the sequence using the buttons “Move up” and “Move down” and deleted
from the sequence with the “Delete X” button. It is possible to edit
parameters which are not defined by the standard before appending the
measurement to the sequence. This is done by clicking the button “Edit and
append”. It is for example possible to assemble a test sequence which
repeats a certain test with different battery voltages.
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Opening an Existing Sequence

The menu item “Sequence - Open ...” opens a file selector for specifying
the sequence to be loaded. The sequence window opens with the specified
sequence loaded. The sequence can then be edited and/or run.

Running a Sequence

When the softkey “Start sequence” is pressed, all checked measurements
in the right list box are executed in sequence. The state of the checkboxes
may be altered by marking a measurement and then clicking on the
checkbox.

Running a Single Measurement within a Sequence

When the softkey “Run highlighted” is pressed, the measurement currently
selected in the right checked list box is executed regardless of its checked
state. Results are added to the result database, however the measurement
started this way will not appear in the sequence report. This allows to use
sequences as customized sets of measurements which can be stored and
opened later again.

Reporting on Sequence Results

A report on all executed measurements of the last run sequence is
prepared and displayed after the “Report Sequence” softkey has been
pressed. After the sequence window has been closed, a report on the last
sequence can be obtained by pressing the “Report last sequence” softkey
in the main window.

42 E-1



Acoustic Measurements on Hearing Aids

8 Reporting, Storing, Loading and Deleting Results

1401.9353.12-01

Result Files

Measurement results are stored together with all associated data in XML
files. Separate files can be used for different projects or operators. They
can be archived together with other project data and re-opened later for
generating reports.

It is recommended to keep result files small and to generate backups at
frequent intervals.

@Hearing Aid Tests

File Data Calibration &

Open results File
Save results
Save results as
Mew resulks File

Load settings
Save setkings
Save setkings as

Exit

Fig. 42 File menu

A new (empty) result file can be created with “File > New Result File” from
the main menu.

An existing result file can be opened with “File - Open Result File” from
the main menu.

A currently opened result file can be stored under a new name with “File >
Save results as” from the main menu.

Report Settings

With “Report > Settings” or “Options = Report settings”, a selection can be
made of data which should appear in the reports. Thus, information which is
the same for a larger number of measurements does not have to be printed
with every report again.

Generating a Single Report

A report on a single measurement result can be generated from the window
of a measurement macro by clicking or pressing the softkey “Generate
report”.

From the result overview of the main window, a report on a single
measurement can be generated by marking the row with the selected result
by clicking on the row header to the left, right-clicking into the data grid and
selecting “Generate report” from the context menu.

Subsequently data associated with the selected measurement is
assembled, a graph for existing curve data is generated, and the preview
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window is opened. Depending on the amount of measurement data, this
may take a few seconds.

Generating a Sequence Report

A report on a sequence of measurements can be generated from the
sequence window by clicking or pressing the softkey “Report sequence”.

Once the sequence window has been closed, a report on the last executed
sequence can be generated by selecting “Report > Last sequence” from
the main menu. Reports about previous sequences can be generated as
single reports on the measurements of this sequence, as all results appear
in the overview data grid in the main window.

Preview Window

@)Repnrt =100 ]
P N xE @& -

I ainFieport |

Erequency Response (Generic)
ROHDE&SCHWAI

Tested: 1/11/2007 4:52:54 PM Print Date: 1/11/2(
Operator:  Rohde & Schwarz

Device Under Test:

Name: other

Type: Standard
Manufacturer: Audiology Inc.
Serial Number: 23498576
AGC: No

Comment: This is my comment

LW S | . ~ATL ¥
4] | »

|CurrEnt Page Mo: 1 |TDIa| Page Mo: 1+ ‘Zuum Factor: 100%

Fig. 43 Report preview window

The main area of the preview window shows a preview of the report as it
will be printed or appear in an exported PDF file. If the report comprises
more than one page, the pages can be browsed using the buttons

LI

To open the print dialog for installed windows printers click

&

To open a file selector for export of the report to PDF, WORD, EXCEL or
Rich Text format, click

e

The scale of the document in the preview can be adjusted with
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Fig. 44 Scale menu of the preview window

Storing and Loading Curves

Measured curves can be stored from and loaded into the graph of a
measurement macro (see above). This allows easy import into
spreadsheets as well as direct comparison of curves measured at different
times or places. Measured curves can also be stored in a R&S UPV limit
file for use as a limit curve either in a R&S UPV sweep graph or in the
graph of a R&S UPV-K7 window. This allows e.g. to derive tolerance
schemes from “golden devices”. The measured curve can be arbitrarily
shifted before being stored.

Shift Curve by n0—= db

Cancel | ] 3

4

Fig. 45 Input window for defining a shift of a measured curve for storage as
limit curve

Deleting Results

It may be desirable to delete results of selected measurements from the
result file, e.g. because the measurement was repeated due to the hearing
aid being switched off, a wrong setting etc. To delete the result of a
particular measurement, mark the row for the selected measurement in the
data grid of the main window by clicking on the row header to the left, right-
click into the data grid and select “Delete result” from the context menu.
After confirmation by the operator, the selected row of the result overview
will be deleted from the result file together with all associated data (except
data also associated with other measurement results).
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Automatic Backup and Restoration of the Results File

In order to speed up the execution of sequences, the result file is only
saved when the program is closed. However, backups of the result file
called “*.xml~1" and “*.xml~2" are stored alternately after termination of
each single measurement and after termination of each sequence (“*”
stands for the name of the results file without extension). If the program is
ended without closing it properly, or if the result file is not existing anymore,
the R&S UPV-K7 will by the time of its next start offer to restore the result
file from the latest backup file:

@Hewer Backup File Found M=l

The last session of this program has ended
prematurely. Not all results have been saved.

Last writing fime of results file:
|1H 172007 4:12:11 PM|

Last writing time of backup file:
|1H 22007 9:40:08 AM

Would you like to backup the contents of the
results file and restore the contents of the backup
file 7

Mo, keep results file | [ Yes, restore backup file |

Fig. 46 Restoration of data from backup file

If it is chosen to restore the result file from the backup, the supposedly
damaged result file is copied do “*.xml~3” before the backup file is copied
to the original name of the results file.
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9 Terminating the Application

The measurement can be terminated from the main window with the “Exit”
softkey. This causes the result file to be written to the hard disk.
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